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Welcome everyone to the Best Practices course ArchiCAD training lesson for Week 24 Detail Drawings.
We'll be continuing on. Last session we looked at the basics of detail drawings. Now we are going to be
extending that a little further with some of the options that we have for referencing them, placeholders,
updating them, rescaling and replacing. So some of these things. And | think in this session we will look
at the use of a legend or template for details. In the U.S. we have MSA Detailer or the detailer section of
the Object library that has some interesting tools. We'll be looking at how you can speed up the creation
of your details with 2D components rather than just doing everything with lines and fills and things like
that. [0:00:56]

By the way, last week's session is posted already here on the basics of detail drawings. If you haven't
reviewed that, then | suggest that you take a look at that video because it went pretty well. We covered
a lot of ground and even went further than just the basics in terms of the Detail Drawing tool. Okay, you
will see here | have the MasterTemplate 18 sample project. Actually, another tiny bit of news is that |
finally got the U.S. version of MasterTemplate for ArchiCAD 18 finished up and posted today. | have sent
out a notice to people who have already purchased it, and | will be announcing it to people who might
be interested in upgrading or purchasing MasterTemplate. [0:01:52]

As you probably know, if you are in the Best Practices course, | often use MasterTemplate as an example
file to demonstrate things and particularly the sample project. It just gives me groundwork for putting
things in context. Okay, so this particular file has now been fully upgraded to work with ArchiCAD 18.
Let's just do a quick review to start out. | will go to a section and place a detail drawing here. | will go
and say that | want to put a detail drawing in this section. | will go to the Detail tool and make sure |
have the geometry. In this case, a simple, rectangular crop will work. [0:02:43]

| am going to create a new detail point. That gives me the opportunity to name it. | will name it “Eave
Detail” here. | will possibly give it a number. The numbers are going to help you organize your details in
the project map. Having done that, | can also choose what layer it's going to be on. If it's on the
ArchiCAD layer, it's going to be seen every time this particular section is brought up, which probably is
okay, but you may want to put it on some other layer. For example, we have a special layer for things
that are unique annotation for plans, sections, and elevations in MasterTemplate. This allows me to
potentially hide some of those annotations and just look at the model in the section or elevation and not
see the annotation. If it's on the ArchiCAD layer, then that wouldn't be the case. [0:03:41]

Let's say | am doing a callout here. | will click two points to create the rectangle, click a third point to
create the elbow for this. And you can see again the reference marker is placed in here. It is a rounded
rectangular cutout or cropping area. If | deselect it, then we are not seeing that cropping area. That will
become important later on, because what we need to do is sometimes be able to see that to edit it.
Now | am going to right click on this and say “Open Detail Drawing”. We are now looking at that context
at a scale initially twice as large as the source view. | am going to change this to something like one and
a half [inches] to a foot here or 1:8. [0:04:28]
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That blows it up. | can go ahead and clean up some of the things | don't need like the boundary or the
gridline here, and start reworking it. That's the basics of creating a new detail drawing. And again, just a
quick reference: if | go to the architectural details sheet here and | go back to this particular detail view,
the view will show up in the detail clone folder if we have a clone folder for details here in the project. If
it's a clone folder, it uses some default settings such as one inch to a foot, which is the setting for the
clone folder. [0:05:14]

In this case | decided that | wanted it to be at one and a half. So | am going to change the scale here to
one and a half. That now allows me to put this detail into a particular grid area. It's rather large. Let's
just drag this around so that it fits in two cells rather than quite as many. Maybe | need to crop it down a
little bit like this so now it's not overlapping that. Let me get the division. Now again, the title here, if |
want a title, which would be common, then | would want to choose here the particular title like this. This
can be moved around and | can also eyedrop any other detail like this one and inject it into this detail,
and that will — oh, that changed the scale. We didn't want that. [0:06:10]

Let's eyedrop this one and inject it into here. One of the things that did was it put the title in the
standard location relative to the grid there. And | might need to change the boundary because it
probably said, “Go out as far as it needs to”, and we may need to crop this a little to avoid having it go
beyond the boundary there. So that's the basics of placing in a detail on a sheet. You can annotate this
and see the annotation show up at the larger scale on the sheet. [0:06:47]

Now what are some of the things that you may need to do that we haven't covered so far? One thing is
we might want to call out this detail from more than one location. We did look at that a little bit last
time. Let's just go to a different section here. So this is A section, let's go to B section. So here is a
different section. Maybe this one doesn't have a compatible one here. Let's say that it's going to be this
area here, it's going to be a similar callout. Instead of creating a new detail, we will place a linked marker
here. The linked marker will either refer to a viewpoint like a detail itself that we just created, like this
one, or it can refer to — and generally it's better to refer to — a first drawing of the selected viewpoint.
That means that it will point at that detail, but it will reference the drawing that | just placed on the
sheet. [0:07:53]

When | do that, now it's a linked marker. | can go ahead and do a callout like that. Now it's showing — let
me move this around and use one of these editing things in the pet palette will allow me to reposition
the callout like this. So this one allows me to move the elbow. This one allows me to move the whole
thing. It's odd in terms of this would normally be just a part of it. And if we do use this, you can see it did
move the whole thing. It didn't move the cropping rectangle. So this one is moving it around in space,
this one is moving just the elbow. | guess there are some subtle differences in what that does. [0:08:46]

Again, the reference here, or in the previous one, we would want to go and make sure in general that
we don't show the name. That's there at the beginning before you place it. It's nice to see what you
have named it, but afterwards we may want it to just reference the sheet here. So this is now linked to
the same one. If | open the detail drawing here, and go back to that section and say “Go to Drawing”
then it will go to the drawing on the sheet. So that's the basics of a callout that is similar. [0:09:24]
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We might actually have a callout that is a little different. If we go to the Roof plan here, this is an eave
detail. | am not sure which part of the roof it is, but clearly you will sometimes take a detail drawing and
want to place a linked marker, but you are not going to want to use the same type of marker, because
it's not going to be a bubble. It's just going to be pointing at it. So let me leave this again as pointing to
the last one we had chosen here. Of course, | can manually do that. Initially | will go and say “Unlock
Layer” here. This particular layer is turned off in this view. [0:10:12]

So this particular detail callout, | want to change the marker style. Let's go in here. Instead of being the
built-in detail marker, | might want to do it as a detail part marker here. This will then create something
that is referencing that. We may want to move this dot over so that it's there. We may want to move the
whole thing over so that it's going in like that. Now you can see that | have something that as soon as |
change the settings here for not showing the name, it will have that number and it will be referring to
this particular section. There are a variety of styles for a detail marker that you can use. This might be
something that you put on a plan for referencing and eave or foundation detail or something that is
essentially defined in another view but is being referenced for convenience in this view. [0:11:18]

Now let's look at something else. If we were to do the placeholders, which | was referring to, then let's
go down to the foundation plan and say that we wanted to have a foundation detail here but we didn't
have this defined. | will go to the Detail tool and say “Place Unlinked Marker” here. | will go and place
this here. So now this is a callout that needs to be linked at some point. | can go around the entire
project and put these in. At some point, | may have created it from another view or | have imported a
drawing onto a layout sheet. | can select this and say that | would like to link it. It's not a source marker,
but | could tell it to link to a particular drawing. [0:12:13]

So we may or may not have a viewpoint defined. That would be a detail drawing within the project map.
But | may have a drawing on a sheet. And that one, | can select drawings on a sheet. And let's go down
to the architectural details, and here is the source detail. This is one that happens to be a foundation
one. It's named here - not related to foundation, but just a source of other details. | am going to say OK.
This now, again, | want to turn off the name here and just have the callout. If | go to that drawing, then
we are going to see it's pointing at this particular foundation detail. [0:12:59]

In fact, let's just go in this particular project and rename this drawing. Now the name of this drawing,
“Example Source Detail”, if we look on the sheet at this example source detail — and either | have this
selected or the same item in the navigator in the layout book, | can go to the drawing settings and you
can see that the name came from the view, “Example Source View”. So | could make it custom and then
edit it manually like this, and just put in whatever | want, or better would be to go to the name of the
view. So where is this view? [0:13:45]

This is in the clone folder for details. Here is that “Example Source Detail”, and | can edit that. And then
it would show up here as well as in the layout as the title of that drawing. Now if | go to the settings of
that view, you will notice that its name, while | could make it custom and change it, actually came from
the project map. So in fact, to reduce confusion, | recommend you go to in this case the source, which
would be the detail viewpoint. When | open it up, you can see here is that viewpoint there. This
particular viewpoint has a name, and | could just call this “Foundation Detail”. [0:14:38]
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Now | have changed it here. It changed in the view map, and it changed in the layout book. If | go back
to the sheet, you will see how it's changed. So that's generally how you want to do it is you want to
name the detail in the viewpoint in the project map when you create it or after you have created it; you
can do it either way. This is actually connected to the marker. If | right-click on this and say "Find Linked
Markers", it says that this detail was placed on the foundation story, or there is a marker linked to it.
And it also is linked here. So we could go and say let's "Go to selected". [0:15:29]

So if 1 go to "Selected" here, there is the original callout. This is actually a linked marker as well. So this is
linked to it. This is not actually the source of that original drawing. And let's go back to the foundation
detail, find linked markers, and we go to the foundation one here, that's the one that | just created. So in
this case, neither one of them was the source of that. So where did that come from? If you think about,
this is really a typical foundation detail that could apply to many different projects, and in fact, was put
in here in this example project for demonstration purposes. It doesn't come from the actual model.
[0:16:26]

However, obviously we want to coordinate the model with this. So this particular detail, if we were to
create that from scratch, or bring that in and make it perfect, then we could easily go and have
references. We could put callouts wherever it's appropriate. And that's what we just demonstrated.
Now if | right click on this, you can see "Open Source View". This will open the actual drawing. Now what
is the source for this? Notice it says "Independent with Markers". This is very useful information. This is
a detail in our project map. It's an independent one as opposed to one that was created from a source.
So you can see the "Eave Detail". Remember, | created a new detail viewpoint. [0:17:29]

And you use the Detail tool to create a rectangle around the eave. Then it created a drawing that | could
start to annotate. So that is a drawing detail. Independent details are created by right clicking in the
detail tool or folder in the project map and saying that you want a "New Independent Detail". Then you
get the opportunity to give it a reference ID and a name. It will then show up in the list here and have a
blank workspace. In other words, it won't have a copy of anything that you are looking at because it's an
independent detail. Once you do that, you can then bring in information like a previous detail from
another project. [0:18:12]

Also from a manufacturer or a hybrid. For example, you can draw some things, copy some things, import
DWG things into it and create that new detail. So an independent detail is something that is very useful.
You can use it when it's appropriate and have other details that are called out directly from a section or
some particular view. Let's see if there are any questions on what | have gone through so far. It was a
quick review of the basics from last time, and starting to go a bit further. So let's see if there are any
questions. [0:18:54]

Okay, so | think it's clear so far. Now, we created something from a standard detail or a drawing like the
Eave Detail here. Now this Eave Detail, let's say that we wanted to start putting some more information
into it and start editing it. This stuff here, this is actually a group. This is placed in the section. | am not
quite sure, this is from the sample project, and | am not quite sure how the insulation would best be
depicted. But | am going to delete that to give us a cleaner representation. And sometimes what you
need to do is go and of course delete some things. Let's say that there is a line here. [0:20:01]
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It's part of a group here. Let's suspend groups so we can select just this one line and take that out. Some
of the things that you may need to do are clean up by removing things. Suspend Groups may be
necessary for that. You also may want to consolidate certain things. Now | am not an architect. | think
most of you know that. Occasionally people believe that because | speak the language pretty well that |
am an architect. But since | am not, | am not going to even attempt to do something realistic with the
detail drawing here. [0:20:45]

But | will show some of the technical aspects of cleaning up the drawing. So let's say this line here, which
is the floor line, | guess this is the story line. Let's remove that if it's not relevant. Now | am seeing this
line, and we have of course these lines here. Now clearly there are some complex relationships that
should be retained. But sometimes you may need to just go and pull things back and clean up some lines
that you didn't model as cleanly as the detail would require. So you can feel free to go and edit these
things, delete extraneous things, just get it good for the basics. [0:21:31]

Now you will also see that for example, this is a fill. That is why it's white against the yellow background.
And here is another fill, and they overlap each other. And sometimes editing these things can get messy.
There is a really wonderful tool that was introduced in AC 12 or 13, that is called "Fill Consolidation".
There is a similar one called "Line Consolidation". | can go to the Edit menu. And you will see "Reshape",
and you will see "Linework and Fill Consolidation" are available, but they are grey, because | need to
select what | would like to edit. [0:22:07]

Now | could select just a part of it or | could select all of it if | want to work on it as a whole. So let me go
to the Edit menu, Reshape, and we'll see "Fill Consolidation" is something here. Right now we have 68
fills. You can see in the info box that we have a bunch of fills here. | can trim the overlapping fills or
merge identical adjoining fills. If the two fills are touching each other and they really are the same style
then it can merge them. There are some additional settings that we have here: whether it's going to pay
attention to the layer or if we want it to maybe keep things separate if they had different layers. There
are some different options here. The default generally works well, at least for me in demonstration
purposes, but you may need to tweak the default here. Once | say OK, you can see it cleaned up a tiny
bit. [0:23:05]

It still says 68, so it didn't actually reduce the number of fills. There are times in certain contexts where
you'll end up with fewer fills because certain things have been merged. Now you'll see this is one fill
here and this is another one. And they just adjoin each other as opposed to overlapping. So that could
make it easier to clean up. Now let's just take this here, | think that's from something in the background
that we don't necessarily want to see. Now similarly, | can go select these elements and go to the
Reshape, Linework Consolidation. This will allow us to take duplicates and replace them. So sometimes
depending on how things are modeled, you may have lines on top of each other and it will make it a
little awkward with editing. So deleting the duplicates would be good. [0:24:03]

If something is a poly line you can explode it so it becomes simple lines. It may be a little bit easier to
edit. There are some other options here that you may or may not want to check in terms of saying you
want to ignore the layer and then put all the lines, even if they are on different layers, onto the
ArchiCAD layer for example; things like that. Say next here. You have some options for how connecting
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lines will be treated. So for example, these two lines that touch each other and essentially here's the
first one, here's the second one, they will become a single line. Of course they will be in one linear
relationship. In other words, not forming a corner or an angle. This is just to show you maybe they came
from different planes in space, but you're looking in a way that they look like they are in the same
connection. [0:25:11]

So you could simplify that. And if they overlap each other, like this, then they would potentially get
merged. So there are different options in the consolidation wizard. The first time you go through it, it
will ask you all of these things and you can make a decision. The next time it will just have a summary
and allow you to do the same thing again. So once you have your preferences set you can just use that
summary very quickly and also go in if you want to go and revise those settings. You can play around
with it. Here, see these are overlapping lines depending on whether they are the same type or not. You
see, "Deleted Duplicates" says four. There were 65 here. Four of them were deleted, two were merged,
three overlapped, etc. So now if we want to, we can say the next time use a simple setting that
summarizes it as opposed to going through the extended questionnaire. [0:26:18]

| will say "Close". Now it says 53. So it took out 12 lines. It's not so much that there are fewer lines. in
other words, ArchiCAD is not going to slow down based on 65 lines versus 53, it's just that editing - if
you have overlapping lines and you try to move or shorten or delete something and there's another line
there, or you are selecting one thing but it's actually selecting something else that overlaps. So
ultimately, consolidation is a good initial step for working on any detail drawing that comes from the
model. You do have to be a little bit careful here. | can see that there's a line here. I'm not quite sure
how this line here and there is - this also must be this fill. Anyway, | can see the line still coming up, but
it’s faint. [0:27:15]

Maybe there some things where | want to take this line and bring it to the front there. Now you can see
it has that common color. If | go back to Onscreen View Options, True Line Weight, we're going to see
something more precise. Now here for example the model was not using the new features in ArchiCAD
17 and later that allow these intersections to clean up. I'm just going to assume that maybe the drywall
here would go up to the framing here, and the ceiling would be put in afterward. So therefore this line
here, if | pull this back, should go to there. Or perhaps in some cases you might want to just indicate
simply that it's wrapping around. So obviously | can start cleaning these things up now that | have the
basic work cleaned up. It's going to be easier to edit. [0:28:23]

Sometimes you are going to be putting in some things. And it looks like, again this particular fill - let's
just say bring to front. That's interesting | didn't really want that fill to bring to the front - let me undo
that - because then the lines didn't come with it. So there are obviously some tricky things that you need
to work with when you are trying to manage what's on top of what. But overall, you have a good
starting point, and you know it's in direct relationship to the model that you made. By the way, this
looks like a fill up above, maybe from the wall behind this. | will just delete that because we don't need
that particular piece there. [0:29:09]

Now the next thing I'm going to show you is how you might use certain objects to add information into
the detail drawing. So when | go to the Object tool, most objects in general are going to have 3D
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representations and we can't really put these 3D objects into a detail drawing because a detail drawing
is all 2D. You'll notice that all the 3D elements are actually grey, because even if there were walls and
roofs and things like that, they are now converted into their graphic equivalents of lines and fills. But the
Object tool still exists because some objects are 2D. In particular, in the U.S. version under the 00
General, there are a variety of 2D symbols. And | especially want to bring your attention to the Detailer
Library 18. [0:30:02]

So the Detailer Library was originally created by an architect named Michael Sotero. He created an add-
on product for ArchiCAD called "MSA Detailer" - Michael Sotero Architects Detailer. Graphisoft
purchased the rights for that back in ArchiCAD 7, so a long time ago, and has carried it forward since
then. Frankly without too many changes, it was a pretty robust resource. And they've just updated it a
little bit here and there. Now let's go to something like a wood shape, here is wood trim. These are
shapes here. Maybe we have the crown molding here. Now let's say there's a crown molding in here.
We might want to model that so that it would show up in the detail, but there are going to be things
that you don't model that you simply want to put into the detail. [0:30:58]

So let's just pick a crown molding here. It has no 3D representation. It's purely a 2D element. And it has
some options for what pens are going to be used. Let's just put it in by the default and say OK. Actually
let's just change the layer from landscape, that wouldn't make much sense. | could put it into the
ArchiCAD layers, saying that it's always going to be seen in this detail or | could be more specific about
the details. Moldings, high, cornice, things like that. | could be very specific about it. In general, most
details are going to be seen in a single way on a single sheet, so it doesn't matter as long as that layer is
visible. But occasionally, you may have a detail where you are showing it at two different scales.
[0:31:45]

And certain details you want to show in one view but not in another. So then the layers will become
more important. I'll just click to place this in. it's obviously facing the wrong way, so | will go and mirror
this like that. And | will drag this into position. Drag this over, until it touches here and then drag it up
vertically there. Now we have the crown molding put in there. So that's an example where yes, we
could've drawn lines and fills to create this, but that was a premade component that made sense. Let's
just go into the Object tool. We could have steel shapes. So if you're putting in some structural steel. We
can have masonry units and wall sections. Or you may want to work with this. [0:32:49]

Let's just pick this brick blocks common CMU. And see here now | have picked a CMU here, and there is
an option for what its view is. Actually, some of these objects can be put in different orientations. And |
wanted to actually do a joist hanger. That's a good example. If | click on this, you can see the preview
indicates this view plus some other stuff, because | could choose to put in this 2D information in another
orientation. So it's a 3D element, it does not actually have 3D representation, but we can choose which
view is the most appropriate view for this. So | guess maybe it's going to be something like that in this
view. And | might actually mirror it here before | put it in. So it probably doesn't fit in to this design here,
but let's just say if | wanted to pop that in | could go and pop it in directly into position. [0:34:07]

You'll notice that the hotspot that was highlighted is where it went in. So when | clicked, this was what
was put in. Sometimes you may want to put it in from a different hotspot. So if | just go ahead and pop
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it in here, you can see that the click point is the point where it got inserted. We still have all of these hot
spots, but | chose which one | wanted to use. So that's an important thing about any object, but
particularly when you're working with these detail objects, is you want to line it up in such a way that it
snaps into position. It will save you time. [0:34:46]

Let's go into the detailer library. Where are the 2x elements? These are all trim. Here, it's under "Wood",
that's right. For some reason | get confused and maybe you have as well. If you're looking for something
that's just a dimensional lumber here for plate or joists or things like that, it's actually under the wood
section but not under the sub folder trim, it's just under the main wood section. So here is an interesting
one that says "Board sides". Now these are set up for U.S. standards, so if you're a metric user | don't
know if Graphisoft has a similar part in the standard library for you. You can do custom here and then
we can actually type in the size. And if you were working with this library in another country and
needed to do it metrically, your dimensions would show up metrically here. So by choosing "Custom"
you would be able to put in your own dimensions for this lumber. [0:36:17]

Now I'm going to pick one of the standard ones. Let's say 2x4 here. And then I'm going to choose
whether it's single or possibly double here. So there are different options like this. | can rotate this
around using the rotate arrow or type in a new angle like that. And | can choose which point I'd like to
pop it in by. Let me choose that, OK, and I'll pop it in here. Obviously we already had some framing in
the section, but essentially that's what was done. This stuff right now is just lines and it could have been
put in as lines in the original section or it could have been put in using that object. So sometimes in a
section, you are going to want to use these tools just as well for elements that should be seen at the
scale of a section. And then they will come across as objects into the detail. [0:37:15]

Then there will be things that you will only put in the detail, perhaps rebar or flashing or other types of
components. So we can use objects from the library, and you might find that you create objects yourself
that you're going to be using in your detail. So if you have created a library of objects, you may want to
install that library and have it available for your projects. Now and object, let's just say this particular
one here not that it's particularly a great example, but it does have actually some little holes indicated. it
has a fair amount of detail. Let's say that we drafted that manually. Let me just simulate this by
dragging a copy of this over here. And we'll just change the settings just to be an end view here. So it's
going to be a little bit more complicated. [0:38:23]

So let's say that we had drawn this. Let me move this to get down here. Let's say that | had drawn this.
Let me simulate that by just doing "Explode into Current View". So | have this selected. I'm going to
explode it. | don't need the original element here; | just want the line work. And let's say that | had
drawn this manually in the context of some detail. And | realized | want to put it into other details. |
could either create an object from it, or the simplest thing is just to go to the Edit menu and Group it.
Now right now groups are suspended. And let's just say ungroup. So here is what it would be when we
started. It would be a bunch of lines, and maybe there are some circles in there. [0:39:23]

But these elements here, | am going to go to the Edit menu and group them. You can see the handles

changed. If | have groups active rather than suspended, then when | select it, | can easily grab this and
move it around or of course drag a copy. Copy it from one detail drawing to another. So this is the
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simplest way to create reusable parts is to take anything that you've drawn in one detail, select it, and of
course you may have to carefully select it out of the middle of what it's in. And maybe you drag a copy
of the detail drawing off to the side or copy it over into a worksheet or something like that and then
break things apart. So do a little bit of editing and get them separated and then group it. So then | will
say "Copy this". And now let's say | wanted to pop this into another detail. Let's just go into the
foundation detail here. | can paste it in here and move this around and put it into position. [0:40:35]

So if it was relevant to another detail here, | could do that. Now this is a group, so it doesn't have any
ability to be numbered or scheduled or things like that. But it works quite well for just copying and
pasting. So one thing you might want to do is collect a bunch of these elements in a convenient location
so you can access them. We could also go to the extent of making this a library part. Then we wouldn't
have to worry about whether groups are active, because half the time | work with groups suspended
anyway, and | go to select this and it just selected one line out of it and | have to turn groups on, etc.
[0:41:25]

But let's say that we wanted to turn this into a library part. It's very simple. In ArchiCAD recent versions
you go to the File menu with these selected, Libraries and Objects, Save Selection as Object. It might be
slightly different in earlier versions of ArchiCAD. Maybe Save selection as and then you choose whether
it's going to be an object or something else like a door or window. But here it directly goes to save
selection as object. And we will just call this "Joist Hanger 1". It will go into the embedded library. That
means it will be available in this project but | can also go ahead and store it somewhere on the hard
drive. This would be a way that ArchiCAD worked before version 13 when embedded libraries became
available. [0:42:12]

But let's just create this. | will say "Save it". And there are some options here for the pens. These were
some different colors; these are at the pens that are currently in use. There are some other options
which I've gone into in the section on creating custom library parts. But let's just say OK. and now this
object exists in the library. It is ready to go and | can just drop it in. and of course maybe the last object |
put in was at 90°, so | could put it back to zero. and now it's going to be something that would be like
this. Now one advantage of the group here is that one can snap to different parts there in this library
part here. [0:43:00]

In fact, the only handles are on the bounding box in the center. So if we wanted this to be as convenient
in terms of snapping, what we would want to do is after creating it, select it, go to the File menu,
Libraries and Objects, Open Object. This brings up the object here. The object's 2D symbol here - this is
actually gets a little bit beyond what | wanted to demonstrate here. | do go into this in the section on
creating custom library parts. What you would want to do is essentially create a version of this that was
a 2D symbol that has hotspots added in to make it convenient for snapping. So you can refer to | think
week 21 where | have a section on adding custom hotspots to the library parts. [0:44:07]

Okay, so here we have a library part, here we have a group of elements, and we might want to be able
to use these elements as well as many other frequently used ones in a variety of detail drawings. So
where could we place it in the project or in a template to speed up the work? Well, we are in
MasterTemplate sample project right now. And let's go to our project map and look under worksheets.
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And you will see there is something called "Detailing Library Parts". Open that up. Look here. These are
selected elements. You may recognize some of them, like the joist hanger. These are selected elements
from the detailer library. Now this was created by Graphisoft years ago, and we've maintained it inside
of MasterTemplate. These are all just components that again are using that same library part that we
were working with. [0:45:21]

But if | wanted to pop these in - let's say | wanted to pop in some masonry, | can go eyedrop this block
here. And notice that | have it from the lower left corner. And let's go to the foundation detail here. And
let's say that | wanted to pop it in. That's interesting; it didn't pop in the same place. Let's go back to
that detailing library parts and eyedrop here. So | am on the bottom right corner, and now let's go back
to the foundation detail and click here. There, it went in. And so not sure what went wrong a minute
ago but that's the idea that you can actually go find these things. They're laid out in a worksheet. And |
can go very quickly back and forth. [0:46:22]

Now it's a little awkward, because I'm in this detail here and the worksheet is up here. But one thing you
can potentially do is share the screen. If you have a large enough screen you can do that. In order to do
that, this is a detail window, and the other one, if | go to the detailing library parts is a worksheet. And
right now you'll notice that the front most window has switched, even though the layout book is still
there. What | would want to do to simplify this is to go to the Options, Work Environment. And | think it
may be Onscreen Options here, no. Maybe More Options. "When opening a view or layout from a menu
or by double clicking in navigator, do | prefer to open in an existing window?" That's what happened
here. | had a detail window open. | went to another 2D area, a worksheet, and it opened it in the same
window. [0:47:30]

Or "Would | prefer to open in new window?" It doesn't affect the floor plan. You can't have the first and
second floor both open in separate windows. In 3D there's only one 3D view. But for details,
worksheets, sections and elevations, if you have this preference changed, then you can go and say work
on the foundation detail here. And these are now two separate ones. And | could arrange this so that |
have whatever shape | want, zoom in on this. And | can go and let's say that I'm going to eyedrop this
one and then go back here and paste it in. Eyedrop something else - what would be useful here? | will
eyedrop this and pop it in here. So you basically go back and forth and pretty quickly build up a detail
from components. [0:48:34]

So these components here are in a worksheet, and it's set up in MasterTemplate for convenience. You
can do that in any project or set it up in your template, which makes the most sense. Whatever effort
you put into for taking Graphisoft library parts or your own library parts, you can set up in a worksheet
and have quick access to them. Now these are all objects which allows me to eyedrop them. So in other
words, | can eyedrop an element like this and then go back here and paste in that element or just click
to place it. But if it wasn't an object, then | would need to copy and paste it. So remember, this is an
object here, but this is a group. And you can see how with groups turned off it doesn't work so well.
[0:49:28]

Let's just go and select this here. I'm going to copy it, and let's say that | wanted to make it available in
here or the reverse. I'm just going to paste it. So | just do Command+C, Command+V, or Ctrl+C, Ctrl+V.
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So I've taken this group and | can drag it over wherever I'd like to group it. So this is an object that | can
eyedrop. This is a set of lines and fills that | can select and copy, and then paste. So it's a slightly
different workflow but the same idea. It's a symbol that we want to bring in to more quickly build up an
actual detail drawing. Another possibility is, instead of having these in two separate windows, that we
go and have this window open and right click on the worksheet that you have for these tools for these
elements, and say "Show as Trace Reference." [0:50:33]

Now you can see that they are in the background here. You can see that they are quite extensive. That
may or may not work, depending upon the layout. So what | might do in this case is open up the Trace
and Reference palette and use the option to drag the reference to a convenient location using this
option here. Now | can have this in one window. Maybe hide that palette if | want. And now I'm working
on the detail, and | can just go and eyedrop elements here and drop them in. Eyedrop an element here,
click on it, eyedrop other elements here and pop them in. So this is very convenient to have it as a
background. It's just a little bit awkward in terms of | have to scroll over to gain access to some of these
other parts. And if it was in a separate window, | could go and just have the window zoomed in to the
area that | want. So there are some tradeoffs here, but this is a really convenient way to do it. [0:51:48]

| remember when | first saw this demonstrated. There is a gentleman from Orcutt Winslow, a very
prominent ArchiCAD firm in Arizona. They are a fairly large firm; | think they were 100 people. I'm not
sure what size they are now. But the gentleman who was describing it, | think it might be Russ Sanders,
he described it as "ice fishing". So if you think about the color here, depending on what color you make
your Trace and Reference. For example, if | make this a grey or something - that's too light here. That's a
little bit better, but let's do a blue here and make it a little bit fainter. It's sort of like they are
underneath the surface, underneath the ice, and yet you can still see them. So you can see this is your
real drawing. You can then again go and "ice fish" and eyedrop something here, then pop it into your
model. [0:52:51]

By the way, if you are relatively new to ArchiCAD - the eyedropper. Of course you can get access from
this little icon here, but | am using the Option key on the Mac or Alt key on Windows to bring up the
eyedropper right on the fly. And that allows me to pick up the settings. So this is a very powerful way to
approach creating detail drawings. There were some comments from the last half an hour.

Bob George asked, "At "Marker", under the Detail tool, there is a detail part marker choice. This feature
includes a small + sign. What is the function of the + sign? There's also a cropping box in that feature
that mystifies me." Okay, so we want to talk about the cropping box and take a look at those options in
the detail part marker. [0:53:45]

Ken Andrews is helping me with, "Under wood". | guess you were pointing out where the framing, the
2x lumber was. Okay, thank you.

Tom Downer asked, "Is there a good reason not to delete all fills in a detail, fix and add line work, and
then just add
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Fills as needed?" That could be a very good strategy. You would want to be careful if there are some fills
that are used to represent things like earth or concrete. Obviously this particular fill is very important. It
indicates that we have concrete. This is earth. But there are some other fills that actually are maybe not
even in this. If we go back to the eave detail | was just starting to work with, all of these fills really are
not saying much. They are clear. The only thing is that there's this one for gypsum board that might be
important; and | guess there's another one down here. [0:54:59]

So what we could do is select all fills. So | just Command+A to select all fills then Shift+click to deselect
these ones. I'm in the Fill tool; Command+A selects all fills. And if | Shift+click to deselect - as part of a
group. | want to suspend groups here. Okay, now deselect this one. If there are some things for
concrete or other stuff we might want to get rid of it, and I'll just hit the Delete key. And well, because |
had the groups active when | started it selected all the linework too. But let's just say "Select all fills"
with the exception of this one, that one, and that one, and delete. And now it looks much the same, but
we still have the fills here for the gypsum and that. So that certainly could be a good starting point for
creating a detail. Thank you Tom. [0:56:11]

It would certainly depend upon how many fills are giving you really useful graphic information versus
just being white things that cover up the lines behind them. So it's up to you, but that might be a good
starting point.

Alright Ken Andrews says, "l always do that with the fills on all my details." Okay, so there you have it.
Question asked by Tom and answered by Ken. Good idea. Go ahead and delete all those fills except for
ones that have a specific use. And even then of course you could always put in fills afterward.

Colin says, "They are grouped." Thank you, yes, | figured that out. [0:56:58]

Bill Ellinger asks, "How do you change the scale or size of the detail components you put in the sheet
detail?" Soin terms of the scale or size, this right now is just a 2D thing. This is the actual object. So
these objects here, in some cases, there are different variations. This is a 2x10; this is a 2x14. Anyway,
these are different dimensions here. So some of these basically you would you might eyedrop them to
get into the right area and then when you open up the object settings pick a different one that is
certainly similar but it's the same idea, just a different one. The other possibility is that in some cases
we may see - let's say the steel shapes here. | think here there are some general ones, like here's the L
shape. And instead of having a lot of different L shapes, it has a little popup that allows you to choose
different types of L shapes. [0:58:12]

So you can see by picking from the popup, these are carefully loaded from the U.S. Steel tables. So these
are standard steel sizes that in general could be used in your buildings without special order or that are
in easily available. So if you're looking at any of the standard steel shapes in the U.S. you can work with
that. So in some cases you would pick a different version of the part; in other cases you might change
the parameter for the size. And yet other ones, let's see. This one doesn't have a custom one in there.
But they are somewhere - obviously we have the lumber here. And it did have some sizing, but then we
also had "Custom" where we can manually type it in. So depending on what it is, you might find you can
grab something that's useful but is not quite the right size then you change it to "Custom". [0:59:13]
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Or worse comes to worse, you can always take what they have, put it in and explode it. And then just
use it as a quick way to get the shape the way you need by redrafting after exploding it. Alright let's see,
| think Bob had that question which we can look at, the detail part marker choice. So let's go back to say
where the detail was called out. I'm going to go to the section here. Here is "Detail callout" here, and
let's go to the option. This it is the built-in detail marker. There are a few different things here. Here is
one called "Detail part marker", and you can see that it has some type of heading, a line, and it looks like
a little flag at the end. [1:00:11]

And you said this feature includes a small plus sign, what is the function of that plus sign? | am not sure
where the plus sign is that you are referring to. We have options for the reference ID and the second
text row. We are going to say "No, don't show the name", just have the number. And the second text
row we'll say we want to show this. For some reason this is no longer thinking that it's referring to a
drawing. So this is a part marker that allows you to put in a reference for a detail but it's not actually
pointing to the detail drawing. This is still referencing a drawing, but this detail part marker does not
allow you to say choose the referenced drawing in here. [1:01:11]

You can see this is gray, so that's a little different. Let me just put it in and say OK. You can put in and
make a callout with some text that you manually put in, but it doesn't understand that. Now if | go back
to where it was, you'll see that as long as this is put in the first place drawing of a viewpoint - okay so
maybe the issue was that something got messed up here. | don't know. This is referring to that. | will say
don't show the name. And let's just switch it now to the detail part marker here. It's still referencing
that. Now it does have that option. So | guess for some reason it didn't have the reference here.
[1:01:59]

Now by the way, this is an interesting option that | forgot to mention. When you are creating a detail,
remember how | drew a rectangle to copy the construction elements into the detail? You can choose to
only copy over the construction elements, meaning walls, slabs, beams etc. and not copy over 2D stuff
like text, dimensions or even other markers. So that way you're starting with a detail drawing that only
has the building elements and not the annotation elements. So if that is checked off when you create a
detail, then it will be simpler. And if you don't have it checked off, then it will copy some of the built-in
referencing. Where this probably gets to be more important is when you're creating a worksheet which
has a similar option. Let's say you had a kitchen plan and there were some gridlines passing through it or
some other text notes that were in at the standard scale for the kitchen. And you're doing an enlarged
kitchen drawing. [1:03:10]

Then when you do the worksheet, you can choose whether to include, if you uncheck this, then it will
include all of the 2D annotation that was already in the kitchen. You can move it around or delete things
you don't want, but you'd be bringing in the stuff that applies. So this says "Only bring in the
construction elements if it's unchecked", then when you are creating a new one or you refresh that
detail, then it will bring in things like section markers are grid markers or text or dimensions and copy
them in there. [1:03:54]

We now can see this is referencing the drawing on the sheet. However | need to edit this arrangement
here. Pop that in. Let's just rotate this around. Now you'll notice as | was doing that it was rotating this
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rectangle. So what is that rectangle? That is the cropping area for this detail. Remember | drew a
rectangle around here, and that's what got copied. See you have to be a little careful with this. And
probably this isn't really the right type of marker to do in this context, but | just wanted to show this
here. Let me undo back. [1:04:19]

Obviously the changes | did earlier did not affect that, but when | said rotate, | rotated the whole thing.
Now let's look at if we did want to rotate just the marker, then you can see the marker angle could be
rotated here. Let's just say 45, and there we go. So the cropping rectangle didn't change, but | typed in a
value and maybe that value is actually available here. So | can say "55" or something like that, and now
we're getting this to be perhaps something that would make sense if we were to put it in here.

Bob says, "The plus appears on the sheet when you place it on the plan sheet." I'm not sure what you're
referring to. So when | place it, you are talking about the detail onto a layout sheet? Is that what you
mean? Or are you talking about when this source drawing, say in this case the section or could be a
plan, is placed on a layout sheet, is there a plus somewhere? So let me know. [1:06:05]

He says, "Now it's not there. I'm talking about the layout sheet." So I'm not quite sure what you're
referring to. If you send me a screenshot, | can look it that before our next session. | think we are little
over the hour mark. I think this is a good point to finish up. We'll do a quick review of what we covered
and what remains to be covered. | went quickly over how you call out a detail and place it on a sheet.
This is sort of a quick review the basics. We went into how you can, when you're creating a detail, how
you can place an unlinked marker and then link it later. Or place a linked marker and choose what you
want to link it to here. [1:06:49]

The main options would be linking it to just a detail drawing viewpoint that already exists or a drawing
that is already placed onto a sheet. If you don't have a viewpoint, if that drawing was just imported -
let's say a standard detail or a manufacturer detail - then there may not be a viewpoint so you just want
to point to that particular drawing on the layout. If you do have a viewpoint which you have created
from calling out part of your model or a new independent detail, then a very common thing is to refer to
the first drawing of the viewpoint. That allows you to get the marker to say where that drawing
appears. But it's linked to the viewpoint, so you can also go and right click and say "Show me the detail,"
so you can tweak it a little bit; things like that. [1:07:40]

In the same way, you can also have the first drawing of the selected view. The difference between
viewpoints and view: viewpoints are in the project map. They are sources for views. Views are in the
view map. They're versions of a viewpoint at a particular scale and with other settings. So if you think
about possibly a detail drawing that exists that you work on, you might have more than one version and
in one view it might have one scale and certain layers. In another view it might have different layers
and/or scales. So that is why at least this is available for referencing. Essentially it's just what's going to
give you the most useful information in the annotation; what is going to automatically link to the right
thing. So if you reorganize anything, it stays connected. Because essentially that's that you want is for it
to fill in for you and to stay connected if you ever change your layout book in any way. [1:08:48]
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Okay. So those are the basics there. We also spent a fair amount of time just looking at building a detail
and using some pre-made components. So we were in the foundation detail here, and | added in some
components. These obviously don't fit into this detail, but just to give you the idea. These are things that
are components. Whether it's something that was drawn from scratch and turned into an object or
some of the ones in the library here. This is, for example, a component here. This is also in the detailer
library. This is an anchor bolt, and if we go in here, the anchor bolt does have some options. You can
change the length. So if | were to make this 18 inches, it's going to go down deeper. And | say OK, and
you can see how it just penetrates that space. [1:09:43]

Let me undo it and you can see what happens here. So they are going to speed up your work. This also
is a base molding that has been placed in here as an object, whereas other things may be just lines. And
of course you have your dimensions and other annotation that are going to show up. So in our next
session we'll be looking at some tools for laying out details neatly. So for example, you'll notice all of
these text items are in line here. you can use a template for laying these out, so that details that are
stacked on top of each other on a sheet will all have a common place where those text items line up. As
well as in some cases, some of the dimension elements might line up. So when you have a grid of
details, it may make your sheet look a little bit more tidy by doing that. [1:10:47]

So we'll be looking at some of the tools for setting up details for standard sizes and making sure that
those details line up nicely. We will also be talking about detail libraries and how you can organize your
details for reuse. And in fact, what I'd like to ask you is if any of you have set up a detail library file, if you
have a file with sheets of standard details that you would be willing to share with me just for training
purposes - in other words, | am not going to give out your details to anybody else. But | would love to
get a few samples between now and Thursday that | can reference and | will pick whichever ones are
most useful for training purposes. [1:11:40]

If you want, | can give you credit on the call and thank you. If you would rather, you can just allow me to
use it and | won't use your name; that's fine too. Let me know. You can send me a file by Dropbox with
a description, or you can e-mail me if you want to check in about it before you send me anything. But |
would love to have some samples. Some of you I'm sure I've done some really good work with
organizing your details in the libraries or having standard reference files with your standard details. And
I'm sure many of you have projects with nice pages full of details. So some of that stuff will be really
useful for me to have onscreen for the next lesson. So please make a note and send it to me as soon as
possible, because that will give me more time to prepare for Thursday's lesson. [1:12:37]

So we have a last question typed in from Ken Andrews. "Annotation size, so they are constant size no
matter what scale?" Okay, so I'm assuming that you might be asking Ken about the fact that this text
here is at 7 pt text. And that means that it's going to be a certain size on paper. And when | look it that
sheet, it's a certain size in relationship to the paper. And when | have something at perhaps a different
scale or no scale at all and it's annotated, how does it match? Obviously this is a bigger text, because it's
not "greeking". Here | have to zoom in a little bit more to see this. So this is a little bit different size.
Basically, when you have your drawing at a certain scale, say 1 inch to a foot or 1 to 10 or whatever scale
is appropriate, when you put in text, for the most part - and this also goes with line weights and in some
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cases bubbles, the size of callouts and tick marks - these are set in terms of the size that they will appear
on paper. [1:13:52]

So it's important that you set your detail drawing early on to the scale that's going to work. It's not that
you can't change the scale, but if you set it to the scale that it's going to be early on and you're putting in
the text and you put it in with your standards - in other words whatever size you like text in general to
be for notes like this - then you'll be able to adjust these and see them how it's going to print out on
paper. On the other hand, if you do this and you change the scale of this and say, well really | need it to
be one and a half to a foot; | need it to be bigger than that. Then the text will change its relationship. In
this case, it wouldn't be much of a problem. [1:14:33]

The drawing would get bigger, because it would be at a larger scale. Instead of 1:12 it would be 1:8. So it
would be 50% bigger, and the text would stay the same size on paper which means that the text items
would get further apart. And so that would most likely work pretty well. obviously if you're doing the
reverse and your taking something that is three inches to a foot which is 1:4 and taking it down to one
and a half inches to a foot which is 1:8, then the drawing is going to get smaller and your text is going to
get more crowded. So then you may have to have more adjustments. But the bottom line is whatever
we're seeing on this paper we want to be able to see here. And if we have this set at the proper scale
rather than - let's make it much bigger here. | am making it bigger, and now you can see the text looks
too small. [1:15:31]

At least | would guess that text is too small. And yet, it's actually going to print out nicely, it's just that
this drawing becomes huge on the sheet. Obviously bigger than it needs to be. So you'll want to set the
scale to the right size that is going to make sense, and then you can see how the text annotation lays
out. And the original size here, if | put this back, this is the size that it was. And you can see how these
things are lined up nicely. Okay, so we will finish up for now. Please add any follow-up comments or
guestions on the page down below this video. Don't forget, if you do have some nice detail drawing
libraries or files with nice sheets of detail drawings | would love to get them for demonstration
purposes. | will not distribute them, | promise. So please send them to me. This has been Eric Bobrow,
thanks for watching.

[END OF AUDIO 1:16:39]
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